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ModusToolbox™ Programmer GUI user guide

ModusToolbox™ Programmer version 5.6

About this document

A newer version of this document may be available on the web here.

Scope and purpose

ModusToolbox™ Programmer is a stand-alone, cross-platform, flash programmer tool that provides a graphical
user interface to Program, Erase, Verify, and Read the flash of the target device. It is delivered with the

ModusToolbox™ Programming tools package, and it supports HEX, SREC, ELF, HCD and BIN programming file
formats.

Intended audience

This document helps you learn how to use the ModusToolbox™ Programmer GUI to perform various operations
on devices.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus

Italics Denotes file names and paths.

Monospace Denotes APlIs, functions, interrupt handlers, events, data types, error handlers, file/folder
names, directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Abbreviations and definitions

The following define the abbreviations and terms used in this document:

Term Description

CMSIS Arm® Cortex® Microcontroller Software Interface Standard.

CMSIS-DAP CMSIS Debug Access Port.

OpenOCD The Open On-Chip Debugger is the debugger tool that provides on-chip programming
support. This tool acts as a backend of the ModusToolbox™ Programmer application.

Data File The data file for programming in the hex or binary format

DP The Debug Port register of the Arm Cortex CPU. Used for programming and debugging,

along with the corresponding SWD-address bit selections.

Flash kernel/loader |The firmware file loaded into the MCU's RAM. Sometimes referred to as RAM program,
Flash kernel, Flash loader.

GDB GNU Project Debugger - GNU.org.

JTAG Joint Test Action Group. Specifies the use of a dedicated debug port while implementing
a serial communication interface for low-overhead access without requiring direct
external access to the system address and data buses.

MCU Microcontroller Unit.

PSOC™ A family of microcontroller integrated circuits. These chips include a CPU core and
mixed-signal arrays of configurable integrated analog and digital peripherals.

Region Logical areas within the target device the programmer operates on.

SWD Serial Wire Debug interface.

QSPI Quad Serial Peripheral Interface. A name used for SPI external memory interfaces
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About this document

Reference documents

Refer to the Infineon programming solutions website for more information as needed.
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1 Overview

1 Overview

ModusToolbox™ Programmer supports the following features:
+  Programming Infineon MCUs' internal and external memories
- PSOC™6 MCUs, including corresponding starter kits and evaluation boards
- PSOC™4 MCUs, including corresponding starter kits and evaluation boards
- PMGL, PAG2S and WLC1 MCUs, including corresponding evaluation boards
- EZ-PD™CCG7S and CCG7D MCUs, CCG2, CCG3PA, CCG3PA2, CCG4, CCG6, CCG8
- XMCT7xxx, XMC5xxx, CYT4BB/BF, CYT2Bx, CYT3Bx/CYT3DL
- PSOC™Control C3
- PSOC™Edge E84

«  AIROC™Wi-Fi/Bluetooth® platforms (CYW4390x, CYW4343W, CYW20829, CYW208xx, CYW55513 and others),
including corresponding starter kits and evaluation boards

«  Connectivity devices via support of development boards

«  Windows, Ubuntu and macOS

«  Programming external memory devices using PSOC™ 6 external memory interfaces (EBI / QSPI)
+  Programming external memory of AIROC™ Wi-Fi devices

+  KitProg3 and MiniProg4 hardware

+  SEGGER J-Link Base and J-Link Ultra hardware

«  OpenOCD via machine interface (M) to 3rd party debug hardware

«  Cross-platform CyBridge library - I2C, SPI, UART communications and USB devices detection

+  KitProg3 firmware update
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2 Installing ModusToolbox™ Programmer

2 Installing ModusToolbox™ Programmer

ModusToolbox™ Programmer is delivered as part of the ModusToolbox™ Programming tools package. A link is
available to download/install from the IDC webpage here:
https://softwaretools.infineon.com/tools/com.ifx.tb.tool.modustoolboxprogtools

For installation details, see section 3 of the ModusToolbox™ Programming tools release notes.
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3 Getting started

3 Getting started

3.1 Run ModusToolbox™ Programmer

To run the ModusToolbox™ Programmer GUI application, navigate to the ModusToolbox™ Programming tools
install location, open the mtb-programmer folder, and run the executable. The GUI opens and looks similar to
this:

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | No programmer found ~ ‘
O] -
© © § 8 5O
= oo SR R i
Open Power Connect Erase Program Read Verify
Device ~ ‘
Settings x
Program Settings
File C:ffirmware/app_combined.hex
Reset Chip
Probe Settings
Log
Info : [CyBridge] Start the APl initialization
Info : [CyBridge] The hardware initialization has completed in 527 ms
Please attach USB probe devicetoproceed e Not Connected ‘

In this case, no kit or device is connected, and a message displays asking you to connect a device.

3.2 Select device
1. Connect the device to the host computer. Select the hardware programmer in the Programmer drop-
down.
ModusToolbox™ Programmer - m] X 1

File View Options Help

Programmer | Select programmer ~ ‘

5 U G WO

T e o S 0

Open KitProg3 CMSIS-DAP BULK-OF0AQA5102122400 Power Connect Erase Program Read Verify
Device ~

2, Select the kit name in the Board drop down.
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3 Getting started

ModusToolbox™ Programmer

File View Options Help

Programmer

KitProg3 CMSIS-DAP BULK-OF0AQA5102122400 ~~ I

Board‘ KIT_PSE84_EVAL \/‘ [L(’D o f:l:

Power Connect Erase Program Read Verify

s

Open

Device

PSE846GPS2DBZC4A g ‘

ModusToolbox™ Programmer displays information under Probe Settings.
ModusToolbox™ Programmer

File View Options Help

Programmer

KitProg3 CM5I5-DAP BULK-OFOADAS5102122400 ~~ I

Board‘ KIT_PSE84_EVAL \/‘ [E’D o ﬂj

s

Open Power Connect Erase Program Read Verify |
Device | PSE846GPS2DBZC4A = ‘
Settings x
Program Settings
File C:ffirmware/app_combined.hex
Reset Chip
Verify Regions
External Memory
Flashloader Default ~
Debug Certificate MNone ~
Probe Settings
Interface SwWD ~
Clock (KHz) 12000 ~
Reset Type Soft ~

Log

Info : Selected Programmer: KitProg3 CMSIS-DAP BULK-0F0AOA5102122400
Info : Selected Board: KIT_PSE84_EVAL
Info : Selected Programmer: KitProg3 CMSIS-DAP BULK-OF0A0A5102122400
Info : Selected Board: KIT_PSE84_EVAL

‘ Press F1 for help _ Not Connected

3.3 Load programming file
1. Click Open.
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MaodusToolbox™ Programmer

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-0FOADAS102122400

r\f? Board | KIT_PSES4_EVAL
Open

k
Device | PSES46GPS2DBICAA

2. On the Open Programming File dialog, navigate to the location of the HEX, SREC, ELF, or BIN file to load,

select it, and click Open.

P
Open Programming File X
’]\ > This PC » Windows (C) > firmware v C Search firmware P
Organize New folder =- 0 @
firmware Name Date modified Type Size
: bin D app_combined.hex 09.09.2025 19:18 HEX File 192
D firmware.bin 17.09.2025 6:52 BIN File 8
v I This PC D firmware.elf 17.09.2025 10:56 ELF File 759
we D PSE846GPS2DBZC4A-EPC2_main.bin 17.09.2025 10:58 BIN File 356
> 'mm= Windows (C)
D read_kp3.hex 17.09.2025 16:06 HEX File 36623
> 3 Network
v ,Q Linux
> Ubuntu-24.04
File name: “ V| Programming Files (*.hex *srec
.
3.4 Connect device
1. If the device is not powered, the status message "Not Powered" is displayed in the Status Bar. Click

Power to power up the device.
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ModusToolbox™ Programmer

File View Options Help

Programmer

MiniProg4 CMSIS-DAP BULK-1704085303147400 ~~ ‘

v‘ e M

I

Board ‘ KIT_PSE84_EVAL

- o x|

EV O N

Open Power Connect Erase Program Read Verify
Device | PSE846GPS2DBZC4A ~ ‘
Settings x
Program Settings
File C:ffirmwarefapp_combined.hex
Reset Chip
Verify Regions
External Memory :‘
Flashloader Default ~
Debug Certificate None ~
Probe Settings
Interface SWD ~
Clock (KHz) 2000 ~
Voltage (V) 1.8 “~
Reset Type Soft ~
Log

Into : Lonnected - MimiFrog4 LMSI5-UAF BULKR-L/U408530314 7400 FW Version 2.80.15.29
Info : Selected Programmer: MiniProg4 CMSIS-DAP BULK-1704085303147400

Info : Selected Board: Custom

Info : Selected Board: KIT_PSE84_EVAL

Info : Selected Board: KIT_PSE84_EVAL

Info : Connected - KitProg3 CMSIS-DAP BULK-OFOAQA5102122400 FW Version 2.80.1529
Info : Disconnected - KitProg3 CMSIS-DAP BULK-OFOAQA5102122400 FW Version 2.80.1529

‘ Press F1 for help Not Powered Not Connected ‘

2, Click Connect. ModusToolbox™ Programmer communicates with the device and displays various
messages in the Log. Then, a message in the Status Bar indicates that it is connected.

3.5 Program device

Click Program. ModusToolbox™ Programmer downloads the program file onto the device and displays

messages in the Log.
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‘ ModusToolbox™ Programmer - O

File View Options Help

Programmer ‘ KitProg3 CMSIS-DAP BULK-OFOAQAS5102122400 ~~

s,

Board ‘ KIT_PSE84_EVAL
Open

Device | PSEB46GPS2DBZCAA = ‘

Settings

|
@ B8 0

Power Disconnect Erase Program Read Verify

Program Settings
File C:/firmware/app_combined.hex
Reset Chip
> Verify Regions
External Memory

(

Flashloader Default

(

Debug Certificate None

Probe Settings

Interface SWD

<

Clock (KHz) 12000

<

Reset Type Soft

<

Log

=3

Info : [100%] [##HHHH# T EHHEHEE] [ Programming |

Info : Padding image section 2 at 0x701077d0 with 2096 bytes (bank write end alignment)
Adding extra erase range, 0x70108000 .. 0x7T013ffff

Info : [100%] [#####HH#HHHHE ] [ Erasing |

Info : [100%] [#HHHHHHH ] [ Programming |

Info : wrote 77824 bytes from file C:/firmware/app_combined.hex in 4.597504s (16.531 KiB/s)

Info : ** Programming Finished **

Info : cyp status: OK

Info : cyp_get_mpn

Info : reset run

R~ o s

3.6 Save log file
Right-click in the Log section and select Save As.

Log

-]

Info : [100%] [###H#HEEE ] [ Programming |

Info : Padding image section 2 at 0x701077d0 with 2096 bytes (bank write end alignment)
Adding extra erase range, 0x70108000 .. Ox7013ffff

Info : [100%)] [##HHHEHEHHHHEHEHHR-S ] [ Erasing ] LO Copy

Info : [100%] [###H#HEEE ] [ Programming |

Info : wrote 77824 bytes from file C:/firmware/app_combined.hex in 4.597504s EEEE Select All CtrltA

Info : ** Programming Finished ** ==

Info : cyp status: OK Save As

Info : cyp_get_mpn Clear

Info : reset run

Ctrl+C

P e S

infineon

Note: You can also select the Select All command to select the text, then copy and paste the text to the file

you selected.
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4 GUI description

4 GUI description

ModusToolbox™ Programmer contains menus and toolbar commands to perform actions. This chapter
describes the various GUI elements.
ModusToolbox™ Programmer - O X
File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-OFOAQAS102122400 ~~ ‘ |
= SR B P N 1 N IR &)
[ C b 4 01 v
Board ‘ KIT_PSE84_EVAL ~ ‘ G O xF i v i _
Open Power Disconnect Erase Program Read Verify |
Device | PSEB46GPS2DBZC4A N ‘
Settings x
Program Settings
File C:ffirmware/app_combined.hex

Reset Chip

Verify Regions

External Memory

Flashloader Default

<

<

Debug Certificate None

Probe Settings

Interface SWD N

Clock (KHz) 12000 g

Reset Type Soft ~
Log

Info : [catld.cm33] external reset detected

Info : [catld.cm33] halted due to debug-request, current mode: Thread

Info : xPSR: 0xf3000000 pc: 0x120015d0 msp: 0x34005¢88

Info : Initializing cmsis_flash bank catld.cm33.main_ns (PSE84_RRAM_NVM)

Info : Initializing cmsis_flash bank catld.cm33.smif0_ns (PSE84_SMIF)

Info : Erasing main flash bank...

Info : [100%] [E#E#ESEREREHBHHEHBBEFREERIREEE] | Erasing |

Info : erased sectors 0 through 355 on flash bank 0 in 2.845885s

Info : Erasing flash bank "cat1d.cm33.smif0_ns" @0x60000000 ...

Info : Using EraseChip API to erase 'catld.cm33.smif0_ns' bank, this may take several minutes...
s
4.1 Menus
4.1.1 File
The File menu contains the following commands:

« Open (Ctrl+0) - Opens the programming file.

« Connect/Disconnect (Alt+Q) - Connects and disconnects the selected device.

+  Program (Alt+G) - Programs the selected device with the selected file.

«  Erase (AWt+E) - Erases the selected device.

« Read (Alt+R) - Reads flash of the selected device into a HEX or SREC file.

+  Verify (Alt+Y) - Verifies that the selected device is programmed correctly.

+ Recent Files - Lists up to five recently loaded programming files.

+  Exit (Alt+F4) - Closes the ModusToolbox™ Programmer application.
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4 GUI description

4.1.2 View

The View menu contains the Settings check box. Select it to view the Settings section of the window; unselect
it to hide the Settings section. See Settings.

4.1.3 Options

The Options menu contains the following commands:

4.1.3.1 Programmer Options (Alt+T)

Opens the Programmer Options dialog to set the Upgrade Firmware mode and other options.

Programmer Options - ModusToolbox™ Programmer X

Name Value

Upgrade Firmware Show Pop-Up ~

Open0CD Telnet Port 4445

PSOC 4 Kill Mode Disable "

0K Cancel

+ Upgrade Firmware mode:
- Automatically - The firmware is updated automatically when the tool opens.
- Show Pop-up - A dialog displays asking if you want to upgrade the firmware.
- Ignore - The firmware is not updated and no prompt displays.
«  OpenOCD Telnet Port: This option specifies the port number of the OpenOCD telnet connection.

«  Kill Mode: Use this option to enable/disable the transition into Kill mode for PSOC™ 4, PMG1, PAG2S, WLC1
and CCGx devices

4.1.3.2 Upgrade Firmware (Alt+U)

When this command is enabled, select it to upgrade the programmer firmware on the device.

4.1.4 Verify Regions
« The Verify Regions menu is available only if Verify Regions option is selected in Program Settings.
+ Add Region - Adds a custom flash region to the Verify Regions list.

+ Reload Regions - Resets the Verify Regions list to the default state corresponding to the flash map of the
target.

« Undo (Ctrl+Z) - Undo the last change in the Verify Regions list.
+  Redo (Ctrl+Y) - Redo the last change in the Verify Regions list.
«  Verify - Initiates the Verify device operation.

4.1.5 Help

The Help menu contains the following commands:
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« View Help (F1) - Opens this document.
+  About ModusToolbox™ Programmer - Opens the About box.

4.2 Toolbar

The toolbar contains the Open, Connect, Erase, Program, Read, and Verify commands, which are also located
on the File menu. This area also contains the following:

4.2.1 Programmer, Board, and Device

Use these pull-down menus to select the specific device to use.

4.2.1.1 Programmer

This displays a list of all currently connected probes with a serial number or other identifier (for example, COM
port number) from which you can select the desired Programmer.

ModusToelbex™ Programmer - O X

File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-0T1106230321040 ~ . . . .

I S = S o X & {3

Open MiniProg4 CMSIS-DAP BULK-0711062303210400 Power Connect Erase Program Read Verify
Device | kitProg2 CMSIS-DAP BULK-201208B202068400

KitProg3 CM5I5-DAP BULK-0T15121T01217400 Ik

Settings x
Program Settings
File C:/CYBCPROTO-062-4243W/CYBCE24ABT|-52D44 CYBCE24ABZI-52D44 BlinkFull.hex E
Reset Chip
Verify Regions
Programming Mode | Reset
Probe Settings
Interface SWD
Clock (KHz) 2000
Vaoltage (V) 3.3
Reset Type Soft
Log
Info : Padding image section 1 at 0x1000b704 with 252 bytes (bank write end alignment] ~

Info : [10090] [#REHHSH IR R ] [ Erasing )
Info : [100%] [#RE#EHTEEEHEHRIARARFREEEEEEE] [ Programming |
Info : wrote 45056 bytes from file C:/CYSCPROTO-062-4343W/CYBC624ABZI-52D44/CYSC624ABZ1-52D44_BlinkFullhex in 3.197801s (13.759 KiB/s)
Info : ** Programming Finished **
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PN: CYBC624ABZI-52D044 SiliconlD: E453 Revision: 12 FamilylD: 102 DIE: PSoCeA2ZM
Info : reset run
Info : JTAG tap: psoc6.cpu tap/device found: 0x6baD0477 (mfg: 0x23b (ARM Ltd), part: Oxba00, ver: Ox6)
Info : JTAG tap: psoc.bs tap/device found: 0x1e453069 (mfg: 0x034 (Cypress), part: Oxed53, ver: 0x1)
Info : Selected Device: CYTC65213-40LQXIT
Info : Connected - KitProg2 CMSIS-DAP BULK-201208B203068400 FW Version 2.80.1506
Info : Connected - KitProg2 CM5IS-DAP BULK-0715131701217400 FW Version 2.70.1480
Recommended to upgrade Firmware of 'KitProg2 CMSIS-DAP BULK-0T15131701217400

Press F1 for help Powered: 3292 mV Mot Connected

4.2.1.2 Board

The Board pull-down allows you to choose the appropriate Kit name for the selected Programmer.
« Under the Scanned Boards entry, there is a short list of best matched Kit names detected by the tool.
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4 GUI description

+ Under the Others entry, there is a list of all other Kit names available for the selected programmer device.

+  When selecting the Custom board, the tool allows you to manually specify the particular target device
connected to a stand-alone programmer (such as MiniProg4) or a KitProg3 with modifiable MCU module.
Custom board is only available for KitProg3, MiniProg4 and JLink programmers.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer |KitProg3 CMSIS-DAP BULK-OFOAQA5102122400 ~~ ‘

(O]
5 oant| cosom = R i
Open Power Connect Erase Program Read Verify
A Custom
Device
Scanned Boards
. KIT_PSEB4_EVAL x
ettin,
= Others
Program Settings CY7110
File CY7111
Reset Chip CY7112
Verify Regions CY7113
Programming Mode CYBCEVAL-06252 —
. . CYBCEVAL-0645X52
Chip Protection . ~
.
4.2.1.3 Device

This displays a list of all supported target devices. It is enabled only if you select Custom for the Board option.

( MaodusToolbox™ Programmer - O X l

File View Options Help

|

| ]
‘ Programmer |KitProg3 CMSIS-DAP BULK-OF0A0A5102122400 -

|

I
D o Sl 0@
Open Power Connect Erase Program Read Verify
Device | CY7C65219-40LQXIT -~ ‘
| XMC5300-F144K2112AA
[ XMC7100-E272K4160 X
| Program Settings XMC7100-F100K1088
File XMC7100-F100K2112
Reset Chip XMC7100-F100K4160

XMC7100-F144K2112

XMC7100-F144K4160

Programming Mode| /1 00.F176K4160 =
Chip Protection XMC7100D-E272K4160 =

XMC7100D-F100K2112

Verify Regions

Prohe Sattinos

4.2.1.4 Auto-completion

Board and Device pull-downs support auto-completion.
Start typing the name of the Kit in the Board pull-down and the tool will suggest corresponding board names.
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4 GUI description

ModusToolbox™ Programmer - O X

File View Options Help

Programmer |KitProg3 CMSIS-DAP BULK-OF0ADA5102122400 ~~ I

S I I L N

1 b4 01 w4
i AN S R C R Y
Open Power Connect Erase Program Read Verify

i KIT_PSE84 EVAL
Device
KIT_PSE84_Al ‘

Start typing the device’s part number in the Device pull-down and the tool will suggest corresponding target
devices.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer |KitProg3 CMSIS-DAP BULK-0FOAOAS5102122400 -~ ‘

E Board‘ Custorn ‘ [lih? (o II:_‘\E'

Open Power Connect Erase Program Read Verify
Device | PSE846GP ‘
PSEB46GPS2DBZCAA
kil PSEB46GPS2DBZCAB X
Program Settings PSEB46GPS2ZDBZQ3A
File PSE846GP52DBZQ3B
) PSE846GPS4DBZC4A
Reset Chip
PSE846GPS4DBZCAB
Verify Regions
PSE846GPS4DBZQ3B
Programming Mode
Chip Protection None ~
4.2.2 Power
it
Use the Power button to power on and off the selected device.

4.2.3 Connect

Use the Connect (D button to connect to and disconnect from the selected device.

4.2.4 Settings

The Settings section of the tool allows you to update the program and probe/target settings as follows:

4.2.4.1 Program Settings

+  File - Use this to select the programming file to perform actions on or with.

+ Offset - Thisis an optional offset parameter; it can be an integer or hexadecimal value. The relocation
offset is added to the base address for each section in the image when the image is programmed. This
option is visible only if a binary or elf file is selected for programming operations.

+ Reset Chip - Use this to reset the chip after the Program operation completes. This option resets the target
chip and runs the programmed firmware on it.
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+  Verify Regions - Use this option to define flash regions used during device verification. This allows to
verify user defined flash regions of the PSOC™ MCU. This option does not change behavior of the Program
operation. See Verify custom flash regions for details.

+ External Memory - Enables/disables the programming of external memory in the target device. For PSOC™
6x MCUs, this option enables programming of the QSPI regions. This is also used for programming external
memory of AIROC™ Wi-Fi devices.

+  Program Security Data - Allows programming security regions if the target device supports this capability.
For example, for PSOC™ 61 PSOC™ 62, and PSOC™ 63 MCUs, this option enables programming the eFuse
region.

«  Target AP - Allows you to select the target access port (DAP) that will be used for programming. Possible
values include: CM0, CM4, and SYS_AP. This option is available only for PSOC™ 64 MCUs.

+  Flash Size Limit - Limits the size of application flash available for programming operations. This option is
available only for PSOC™ 64 MCUs.

+  Programming Mode - Use this option to define programming mode for PMG1 devices. The mode options
include:
- Reset: This programming mode enables acquisition of the target device in the Test mode.
- PowerCycle: In this mode, the programmer cycles power to acquire the device.

«  Flashloader - Use this option to select the patched QSPI CMSIS flashloader file (in FLM format). This
flashloader is used for external flash programming.

Note: To be able to program custom external flash you should also provide the appropriate QSP!
configuration file (gspi_config.cfg), generated by the ModusToolbox™ QSPI Configurator tool. This
file should be located in the same directory as the patched flashloader file.

+ Debug Certificate - Use this option to specify the location of the debug certificate binary file. The debug
certificate is used for programming AIROC™ CYW20829 targets in Secure lifecycle mode.

+  ECC Config - Use this option to enable or disable the ECC error reporting. This option is only applicable for
read flash operations of some MCUs.

«  Chip Protection - Use this option to apply Chip Protected or Kill mode for PSOC™ 4, PMG1, PAG2S, WLC1
and CCGx devices.

+  RRAM Offset - Use this option to modify the offset for RRAM memory (flash bank) for PSOC™ Edge E84 EPC4
devices. The minimal allowed RRAM offset value is 0xA000.

4.2.4.2 Probe Settings

The Probe settings allow you to configure the programming and target device before you connect to it. These

settings are available when ModusToolbox™ Programmer is not connected to the device.

+ Interface - To select the hardware (debug) interface for communication with the target device. The
possible values include: SWD and JTAG if supported by the device.

+  JTAG Chain - To select the interested target device in the JTAG chain. This option is only available for
probes supporting JTAG interface. See Program PSOC™ 6/Control C3/Edge E84 MCU in JTAG chain for
details.

+  Voltage (V) -To select the power supply voltage of the target device in Volts. This option is available only if
the selected probe has the power control capability.

+  Clock (KHz) - To select the frequency of the hardware interface in KHz. This option is available only if the
selected probe supports configurable frequencies.
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+ Reset Type - Specifies the type of the Reset Chip operation. The possible values include: Soft and XRES:
- Softis a software reset type that sends the system reset request to the ARM core.
- XRES s a hardware reset type that toggles the XRES hardware line.

+  Sflash Restrictions - Specifies the Sflash programming behavior. This option is available only for PSOC™
61/62/63, XMCTxxx/XMC5xxx, FX3G2, CYT3Bx/CYT3DL, CYT4Bx, CYT4DNJ, and CYT2Bx MCUs. The possible
values include:

- Erase/Program of Sflash is prohibited.

- Erase and Program of USER/TOC/KEY is allowed.

- Erase of USER/TOC/KEY and Program of USER/TOC/KEY/NAR is allowed.
- Erase and Program of entire Sflash is allowed.
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5 Programming operations

This chapter covers the various programming operations you can perform using the ModusToolbox™
Programmer tool.

+ Erasedevice

+  Program device

+  Program device and Reset Chip

«  Program binary file with Offset

«  Program External Memory

+  Program PSOC™ 6/Control C3/Edge E84 MCU in JTAG chain

+  Verify device

«  Verify device with External Memory

+  Verify custom flash regions

+ Read device

+  Program eFuse region of PSOC™ 6/TRAVEQ™ T2G/XMC7xxx/XMC5xxx MCU
+  Program chip-protected/Kill Mode for PSOC™ 4 MCU

+  Program secure AIROC™ CYW20829 MCU

+  Program QSPI memory with patched flashloader

+  Program AIROC™ CYW955513EVK-01 and CYW9M2BASE-43012BT boards

5.1 Erase device
1. Connect to the device (see Connect device).
2. Click the Erase button.

ModusToolbox™ Programmer erases the device and displays various messages in the Log. Then, a message in
the Status Bar indicates that the device was erased successfully or that an error occurred.

ModusToolbox™ Programmer = a X
File View Options Help
Programmer |KitProg3 CMSI5-DAP BULK-OFDADAS102122400 ~~

Eaardl KIT PSES4 EVAL s - E 5 [[jf 1:; I

Power Disconnect || Erase BProgram Read Verify

Device | PSEB4GGPS2DBICAA e
Settings X
5.2 Program device
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.
2, Select the programming file as described in Load programming file section.

3. Connect to the device (see Connect device).
4, Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that device was programmed successfully or that an error occurred.
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ModusToolbox™ Programmer — ] X

File View Options Help

| Programmer |KitProg3 CMSIS-DAP BULK-OFOAQAS5102122400 ~~

L7 Board‘ KIT_PSE84_EVAL v‘ [LQ’) [I'_>f f:l: !

Open Power Disconnect Erase |Programl Read Verify

Device | PSE846GPS2DBZC4A = ‘

Settings x

Program Settings
File C:/firmware/app_combined.hex

IReset Chip I I

Verify Regions

External Memory

Flashloader Default N
Debug Certificate Mone hd
5.3 Program device and Reset Chip
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.

2, Select the programming file as described in the Load programming file section.
3. Connect to the device (see Connect device).

4, Select the Reset Chip check box under Program Settings.

5. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | KitProg3 CM5IS-DAP BULK-0F0ADA5102122400 ~~ ‘

= 0] X |
L7 Board‘ KIT_PSE84_EVAL v‘ (s (o f:l: '

Open Power Disconnect Erase | Program | Read Verify
Device | PSE846GPS2DBZC4A e ‘
Settings X |
Program Settings
| File C:/firmware/app_combined.hex

I Reset Chip I

Verify Regions

External Memory

Flashloader Default ~
Debug Certificate None hdl
The target device is reset and running.
5.4 Program binary file with Offset
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.
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Select the binary programming file as described in the Load programming file section.
Connect to the device (see Connect device).

Enter the desired address in the Offset field under Program Settings.

. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer — ] x
| File View Options Help
|
| Programmer |KitProg3 CMSIS-DAP BULK-0OFOAQAS102122400 ~~
M— 10} X
L7 Board‘ KIT_PSE84_EVAL V‘ = =~ = g ¥ E
Open Power Disconnect Erase Program Read Verify
Device | PSEB46GPS2DBZC4A el ‘
| Settings x
|| Program Settings
File C:ffirmware/firmware.bin
| offset 022011000 |
Reset Chip

Verify Regions

External Memory

Flashloader Default hd
Debug Certificate None ~
Note: Offset options is available only for binary programming files.
5.5 Program External Memory
1. Attach and select a device that supports external memory (for example, CY8CKIT-062-WiFi-BT with QSPI
support).
2, Select the External Memory option under Program Settings.
Settings *
Program Settings
File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex E
Reset Chip

Verify Regions

[ External Memory v
Program Security Data | ]

! Probe Settings
Interface SWD
‘ Clock (KHz) 3200
Voltage (V) 33
| Resat Type Soft
| [ Sflash Restrictions Erase/Program USER/TOC/KEY allowed |

3. Select the programming file as described in the Load programming file section. The programming file
should contain external memory region(s) and correct QSPI configuration data.

4, Select Erase/Program USER/TOC/KEY allowed option under Probe Settings > Sflash Restrictions.
This is only needed for PSOC™ 6 devices.

5. Connect to the device (see Connect device).
6. Click the Program button.
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ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

| Programmer |KitProg3 CMSIS-DAP BULK-OFOAQA5102122400 ~~ ‘
S O X i
L L x 01 v
L7 Board ‘ KIT_PSE84_EVAL ~ ‘ 5 = = 1] f:l: 2
Open Power Disconnect Erase |Program| Read Verify
Device | PSEB46GPS2DBZC4A e ‘
Settings xX
Program Settings
File C:/firmware/app_combined.hex
Reset Chip
Verify Regions
External Memory
Flashloader Default ~
Debug Certificate None hd
Probe Settings
Interface SWD ~
Clock (KHz) 12000 b
Reset Type Soft ~
Log
Info : Initializing cmsis_flash bank catld.cm33.smif0_ns (PSE84_SMIF)
Info : Reading flash banks ...
Info : flash 'cmsis_flash' found at 0x22011000
Info : flash 'cmsis_flash' found at 0x60000000
Info : #0: catld.cm33.main_ns (cmsis_flash) at 0x22011000, size 0x00059000, buswidth 4, chipwidth 4
Info : #1: catld.cm33.main_s (virtual) at 0x32011000, size 0x00059000, buswidth 4, chipwidth 4
Info : #2: catld.cm33.smif0_ns (cmsis_flash) at 0x60000000, size 0x01000000, buswidth 4, chipwidth 4
Info : #3: catld.cm33.smif0_s (virtual) at 0x70000000, size 0x01000000, buswidth 4, chipwidth 4
Info : Flash banks detected
Info : cyp status: OK
‘ Connected to the target device Powered: 1796 mV  PSEB46GPS2ZDBZC4A ‘
™ . .
5.6 Program PSOC™ 6/Control C3/Edge E84 MCU in JTAG chain
1. Connect the host computer to a MiniProg4 or J-Link probe attached to several MCU targets in the JTAG
chain.
The following hardware configuration is used in this example:
MiniFrogd -
oI DO
PSoC 6-1M

PSoC 6-512K

- AP 11

PSoC 6-1M P30C 6-512K PSoC 6-1M | PSoC6-2M
\—a[ mPaH mPs]—v['raH H raps} TAPGHT;.F? ]-—»[ mPeH r.:.Pg]—'

The sample JTAG chain configuration contains six serially-connected PSOC™ MCU targets.
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2, Select the MiniProg4 probe and target device in the Programmer, Board, and Device drop-downs, and

ModusToolbox™ Programmer will display information under Probe Settings. Ensure the JTAG chain is
powered.

3. Select the JTAG interface in the Interface drop-down.

ModusToolbox™ Programmer = O x
File View ©Options Help
Programmer |MiniP|’0g4’CMSI5-DAP BULK-0T110623032104( - |
) T T
r_| C [ iXf joip § ivE
7 BDardlCustom . | LJ D e e L b
Open Power Connect Erase Program Read Verify
Device | CYBCE24ABZI-S2D44 . |
Settings x
Program Settings
File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex (L)
Reset Chip
Verify Regions
External Memory
Program Security Data
Probe Settings &
Clock (KHz) SWD
Vaoltage (V) I ITAG
Reset Type Soft
Sflash Restrictions Erase/Program Sflash prohibited w

ModusToolbox™ Programmer queries the JTAG chain and displays detected devices under the JTAG
Chain option in Probe Settings. The list of devices in the chain contains target names for supported
devices and ID codes for those which are not supported.

ModusToolbox™ Programmer = O X
File View Options Help
Programmer | MiniProg4 CMS15-DAP BULK-07110623032104( - |
rﬁ [ C IxXfF  qoif | ivE
7 BDard|Cu5lom - | LJ D b b L ey
Open Power Connect Erase Program Read Verify
Device | CYBC624ABZI-52D44 . |
Settings x
Program Settings
File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex ()
Reset Chip
Verify Regions
External Memory
Program Security Data
Probe Settings -
Interface |6
v JTAG Chain =
[ [0] CYBCE24ABZI-52D44 @ I
Clock (KHz) 2000
Voltage (V) 13
Reset Type Soft
v

4, Select the desired target device in the list by clicking the radio button next to the target name.

5. Select the programming file as described in the Load programming file section.

6. Click Connect. ModusToolbox™ Programmer communicates with the device and displays various
messages in the Log. Then, a message in the Status Bar indicates that it is connected.
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Loy
||Eu THI T PEOCG_ST0SE_CIY [PS0UG_Z1T_ST0Se] J0 RS0 U0, SIEE URIOUOUOD, SWIOTT L, CITPWIOOT L
Info : #4: psoc6_main_cm4 (virtual) at 0x10000000, size 0x00000000, buswidth 0, chipwidth 0
Info : #5: psoct_work_cmd (virtual) at 0:x14000000, size 0x00000000, buswidth 0, chipwidth 0
Info : #6: psoch_super_cmd (virtual) at 0x16000000, size 0x00000000, buswidth 0, chipwidth 0
Info : #7 : psoc6_efuse_cmd4 (virtual) at 0x90700000, size 0x00000400, buswidth 1, chipwidth 1
Info : Flash banks detected
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PN: CY8C624ABZ1-52D44 SiliconlD: E452 Revision: 12 FamilylD: 102 DIE: PSoCGAZM

Connected to the target device _ CYBCH24ABZ1-52D44

7. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

| Programmer |KitProg3 CMSIS-DAP BULK-OFOAQA5102122400 ~~ ‘
(L] X
e © o 8808
L7 Board ‘ KIT_PSE84_EVAL s ‘ . . \ .
Open Power Disconnect Erase Program Read Verify
| Device | PSEB46GPS2DBZC4A e ‘
|
| Settings X
| | Program Settings
File C:ffirmware/app_combined.hex

Reset Chip

> Verify Regions
External Memory
Flashloader Default ~
‘ Debug Certificate None ~
‘ Probe Settings
| Interface SWD ~
Clock (KHz) 12000 ~
‘ Reset Type Soft N
| Log
| =
Info : flash "virtual’ found at 0x32011000
‘ Info : ** Probing bank 2 **
| Info : flash 'emsis_flash' found at 0x60000000
|| Info:** Probing bank 3 **
l Info : flash ‘virtual’ found at 0x70000000
|| Info : ** Verifying image C:/firmware/app_combined.hex offset:0 **
Info : verified 69868 bytes in 0.967814s (70.500 KiB/s)
‘ Info : cyp status: OK
Info : ** Verified OK **
f Info : cyp_get_mpn
5.7 Verify device
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.
2, Select the programming file as described in the Load programming file section.
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3. Connect to the device (see Connect device).
4, Click the Verify button.

ModusToolbox™ Programmer performs the Verify device operation and displays various messages in the Log.
Then, a message in the Status Bar indicates that the device was verified successfully or that an error occurred.

MaodusToolbox™ Programmer — (] X

File View Options Help

Programmer |KitProg3 CMSI5-DAP BULK-OFOAQA5102122400 ~r ‘

B BOBFE" KIT_PSE84_EVAL ~ ‘ Hihl)) [|—_>j m !

Open Power Disconnect Erase Program Read | Verify
Device | PSEB46GPS2DBZC4A ~ ‘
Settings X
Program Settings
File C:/firmware/app_combined.hex
Reset Chip
Verify Regions
External Memory
Flashloader Default ~
Debug Certificate None hd
Probe Settings
Interface SWD ~
Clock (KHz) 12000 =
Reset Type Soft ~
Log
Info : flash 'virtual' found at 0x32011000
Info : ** Probing bank 2 **
Info : flash 'cmsis_flash' found at 0x60000000
Info : ** Probing bank 3 **
Info : flash 'virtual' found at 0x70000000
Info : ** Verifying image C:/firmware/app_combined.hex offset:0 **
Info : verified 69868 bytes in 1.004773s (67.906 KiB/s)
Info : cyp status: OK
Info : ** Verified OK **
Info : cyp_get_mpn
‘ Device verified successfully Powered: 1796 mV Connected

5.8 Verify device with External Memory

1. Connect the device that supports external memory (for example, CYS8CKIT-062-WiFi-BT with QSPI
support) to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load programming file section. The programming file
should have external memory region(s).

3. Select the External Memory option under Program Settings.
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ModusToolbox™ Programmer

File View Options Help

| Programmer | KitProg3 CM5IS-DAP BULK-OFOAOA5102122400 -~
| 0]
1
7 Board ‘ KIT_PSE84_EVAL ~
Open Power
Device | PSEB46GPS2DBZCAA ~ ‘
|
| Settings

o & 3

Erase Program Read Verify

Program Settings

File C:/firmware/app_combined.hex
Reset Chip
Verify Regions
I External Memory v
Flashloader Default
Debug Certificate None
4, Connect to the device (see Connect device).

5. Click the Verify button.

infineon

ModusToolbox™ Programmer verifies the device and displays various messages in the Log. Then, a message in

the Status Bar indicates that the device was verified successfully or that an error occurred.
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ModusToolbox™ Programmer - O X

File View Options Help

| Programmer | KitProg3 CM5IS-DAP BULK-OFOAOA5102122400

2
Iﬂfi Board‘ KIT_PSE84_EVAL v‘ [LQ)) [L)j fI :
a

Open Power Disconnect Erase Program Read Verify

Device | PSEB46GPS2DBZCAA

| Settings xX

Program Settings

File C:/firmware/app_combined.hex
Reset Chip
> Verify Regions

External Memory

‘ Flashloader Default ~
Debug Certificate None hd
‘ Probe Settings
| Interface SWD ~
‘ Clock (KHz) 12000 b
| Reset Type Soft ~
| Log
| =2
Info : flash ‘virtual’ found at 0x32011000
‘ Info : ** Probing bank 2 **
|| Info : flash 'emsis_flash' found at 0x60000000
[| Info:** Probing bank 3 **
| Info : flash "virtual' found at 0x70000000
|| Info : ** Verifying image C:/firmware/app_combined.hex offset:0 **
Info : verified 69868 bytes in 0.967814s (70.500 KiB/s)
‘ Info : cyp status: OK
Info : ** Verified OK **
! Info : cyp_get_mpn |
5.9 Verify custom flash regions
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.
2, Select the programming file as described in the Load programming file section.

3. Connect to the device (see Connect device).

4, Expand Verify Regions option in Program Settings to see the list of flash regions available for verification.
By default, only supported by target device regions are displayed:

« application

+ AUXflash
« Sflash
« eFuse
« QSPI
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Program Settings

File C:/firmware/app_combined.hex

Reset Chip

~ Verify Regions

From To

0x22011000 Ox2206891TF
0x32011000 0x320691FF
0x60000000 OxeOLLLEFT
0x70000000 OxVTOLLLLLL

External Memory

Flashloader Default ~
Debug Certificate None N
5. Right-click on Verify Regions or any region entry to open the context menu.
Program Settings
File C:/firmware/app_combined.hex
Reset Chi -
eset Chi
P Add Region
~ Verify Regio
Reload Regions
From
0%2201 Undo Ctri+Z
0x3201 Ctrl+y
0x600( Verify
0x70000000 OxVOLELEfrE
External Memory
Flashloader Default ~
Debug Certificate None ~

6. To add a custom flash region, select Add Region. Select the added list entry, and enter the correct values

for start and end addresses of the region.

Program Settings

File C:ffirmware/app_combined.hex

Reset Chip

~ Verify Regions

From To

0x22011000 O0x22069C1T
0x32011000 0x32069EFT
0x60000000 OxeOLELEFY
0x70000000 OxVOLELESY

@ 0x00000000 @ 0x00000000

External Memory

Flashloader Default

¢

Debug Certificate None

<

7. To remove any region in the list, right-click the desired region entry and select Remove Region.
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Program Settings
File C:ffirmware/app_combined.hex
Reset Chip
~ \Verify Regions
From To
0x22011000 0x22060FFF
Add Regi
0x32011000 0x3206 egion
0x60000000 Ox6OLT
0x70000000 0xTOEE Ctrl+Z
External Memory Redo Ctrl+Y
Flashloader Default Verify ~
Debug Certificate None s
'9 Ctrl+z
Probe Settings
c}{) Ctrl+x
Interface SWD D ~
Ctrl+C
Clock (KHz) 12000 L ~
Reset Type Soft I:a Ctrl+v -
Log
==
= 199 SelectAll Ctrl+A
Info : flash 'virtual’ found at 0x32011000 ==
Info : ** Probing bank 2 **
Info : flash 'emsis_flash' found at 0x60000000
Info : ** Probing bank 3 **

8. To revert any previous change, select Undo.

9. When finished with the list of regions, start device verification by clicking the Verify button on the
toolbar.

ModusToolbox™ Programmer

File View Options Help

Programmer

KitProg3 CMSIS-DAP BULK-OFOADAS102122400 ~~ ‘

E Board‘ KIT_PSE84_EVAL v‘ [LQ’) [L)J( f:l: !

Open Power Disconnect Erase Program Read | Verify

Device

PSE846GPS2DBZC4A ~ ‘

You can also select Verify on the context menu.

user guide 29 002-25230 Rev.*P
2025-09-24



o~ _.
ModusToolbox™ Programmer GUI user guide |n f| neon

5 Programming operations

Program Settings
File C:ffirmware/app_combined.hex
Reset Chip
~ Verify Regions
From To
0x22011000 0x22069CTT
0x32011000 Ox32069LFF
(]KE‘,(](](](]“HH NueNFFFFFF
i Add Region
0x7000(
External Mem Remove Region
Flashloader Ctrl+Z "
Debug Certifi Redo Ctrl+Y T
Veri
Probe Settings Ify_l
Interface 9 Ctrl+Z ~
Clock (KHz) / ~
(}b Ctrlax
Reset Type ~
LO ctrlsc
Log CtrlsV
v )
Info : ** Probing @
Info : flash 'virtuz oo Select All Crlin
H elec rl+
Info : ** Verifying 29 _Jd.hex offset:0 **

Info : verified 69868 bytes in 1.000321s (68.209 KiB/s)

ModusToolbox™ Programmer verifies only the regions specified in the Verify Regions list. Then, a
message in the Status Bar indicates that the device was verified successfully or that an error occurred.

10. Toreset the Verify Regions list to its default state select Reload Regions from the context menu. This
action will remove all custom regions and load default regions corresponding to the flash map.

Program Settings

File C:/firmware/app_combined.hex
Reset Chi~ L
« VerifyRe Add Region
Fron
0x2: Ctr+Z  ref
0x3: Redo Ctrl+Y Irf
0x6 Verify rrf
0x70000000 URTOLLLLEE

External Memory

Flashloader Default ~
Debug Certificate None o
5.10 Read device
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.
2. Connect to the device (see Connect device).
3. Click the Read button.
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ModusToolbox™ Programmer

File View Options Verify Regions Help

KitProg3 CM5I5-DAP BULK-0F0ADA5102122400 ~~ ‘

| Programmer
©} X
© o §® @[5l
L7 Board‘ KIT_PSE84_EVAL ~ ‘ & o v &
Open Power Disconnect Erase Program} Read Verify
Device | PSEB46GPS2DBZC4A 7

4, On the Read Device to File dialog, navigate to the location of the HEX or SREC file to be saved, enter the
file name, select the file type in the Save as type drop-down, and click Save.

Read Device to File X
« v 1 <« CYBCKIT-062-BLE > read v O | Search read A
Organize = Mew folder CE=
= Documents ~ MName Date modified Type
¥ Downloads
No items match your search.
D Music
= Pictures
E Videos
L+ Windows (C)
v < >
File name: w
Save as type: |Programming File (*.hex) e
~ Hide Folders Cancel

Note: Under Ubuntu Linux, specify the full file name with an extension (e.g. kp3-dev.srec); otherwise, the file
will be saved in HEX format.

ModusToolbox™ Programmer performs the Read device operation and displays various messages in the Log.
Then, a message in the Status Bar indicates that the device was read successfully or that an error occurred.
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5 Programming operations

ModusToolbox™ Programmer - O X

File View Options Verify Regions Help

| Programmer | KitProg3 CMSIS-DAP BULK-OFOAOA5102122400 ~~

B Board‘ KIT_PSE84_EVAL v‘ [E’D [I'_>j m

Open Power Disconnect Erase Program Read Verify
Device | PSEB46GPS2DBZC4A N~
Settings xX
Program Settings
File C:/firmware/app_combined.hex

Reset Chip
Verify Regions

External Memory

| Flashloader Default

(

Debug Certificate None

(

| | Probe Settings

| Interface SWD ~
Clock (KHz) 12000 7
Reset Type Soft ~

| Log

|| Info : wrote 364544 bytes to file C:/Users/Sopilko/AppData/Local/Temp/dump_1_0x32011000.bin from flash bank 1 at offset 0x00000000
in 1.445699s (246.248 KiB/s)

| Info : ** Reading bank 3, filename C:/Users/Sopilko/AppData/Local/Temp/dump_3_0x70000000.bin **

Info : wrote 16777216 bytes to file C:/Users/Sopilko/AppData/Local/Temp/dump_3_0x70000000.bin from flash bank 3 at offset

|| 0x00000000 in 46.126476s (355.197 KiB/s)

: Info : cyp status: OK

Info : ** Reading bank 1, filename C:/Users/Sopilko/AppData/Local/Temp/dump_1_0x32011000.bin **

|| Info : Converting read binary files to C:/firmware/read_kp3.hex
Info : ** Read device Finished **

Info : cyp_get_mpn

Device read successfully to C:/firmware/read_kp3.hex Powered: 1795 mV Connected

Note: Read Device feature is not available for the boards based on WICED-Bluetooth hardware
programmers.

5.11 Program eFuse region of PSOC™ 6/TRAVEO™ T2G/XMCT7xxx/XMC5xxx
MCU

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.

2, Select the programming file as described in the Load programming file section. The programming file
should contain valid eFuse data region (at address 0x90700000).
3. Select the Program Security Data check box under Program Settings.
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5 Programming operations

File

ModusToolbox™ Programmer

View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-07110623032104C -~ |

B Board|(:ustom v| [L(JD o, m

Open Power Connect Erase Program Read Verify
Device | CY8C6245LQ1-53D72 s
Settings

Program Settings
File C:/hex/efuse_secure.hex E
Reset Chip n
Verify Regions
External Memory

[ Program Security Data

Probe Settings
Interface SWD ~
Clock (KHz) 2000 o~
Voltage (V) 25 ~
Reset Type Soft 7
Sflash Restrictions Erase/Program entire Sflash allowed ~

Log

Info : [CyBridge] Start the APl initialization

Info : [CyBridge] The hardware initialization has completed in 2917 ms

Info : Connected - MiniProg4 CMSIS-DAP BULK-0711062203210400 FW Version 2.80.1506

Info : Selected Programmer: MiniProg4 CMSIS-DAP BULK-0711062303210400

Info : Selected Board: Custom

Info : Selected Device: CY8C6245LQ1-53D72

Press F1 for help

4, Connect to the device (see Connect device).
5. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.
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ModusToolbox™ Programmer I,\\) — O

File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-0T1106230321040~~ |

Reset Chip E
» Verify Regions
External Memory

Program Security Data

0] X
E CRC I 3 - R ol
7 Board |Custom ~ | 5 - . m ¥ .
Open Power Disconnect Erase Program Read Verify
Device |CY8C6245LQI—53D72 ~ |

Settings

Program Settings

File C:/hex/efuse_secure.hex

Probe Settings

Interface SWD =

Clock (KHz) 2000 ~

Voltage (V) 2.5 ~

Reset Type Soft e

Sflash Restrictions Erase/Program entire Sflash allowed ~
Log

U FaUUIng iage SELLIUTT U dL UATU TUUL0U WILIT DT L UYLES (LdiTh WIHILE ENTU dUEITTETNL]

Info : Erase operation for EFuse bank is not supported, skipping

Info : wrote 1024 bytes from file C:/hex/efuse_secure.hex in 0.137065s (7.296 KiB/s)

Info : ** Programming Finished **

Info : cyp status: OK

Info : cyp_get_mpn

Info : ** Detected device PN: CY8C6245LQI-53D72 SiliconID: ET01 Revision: 13 FamilylD: 105 DIE: PSoC6A512K
Info : reset run

Info : SWD DPIDR Ox6ba02477

oty e

infineon

If some eFuse bits have been already programmed before, a warning message "The efuse bit at address xx has

been already blown" appears in Log.

Log

Info : psocb.cpu.cmd halted due to debug-request, current mode: Thread
Info : xPSR: ©x61000000 pc: @x1600400a msp: 00000000

Info : ** Programming Started **

Info : auto erase enabled

The efuse bit at address @x7F[6] has already been blown
The efuse bit at address @x7F[7] has already been blown
Info : The Life Cycle stage is not present in the programming file
Info : wrote 10824 bytes from file (:/hex/efuse/efuses.hex in 2.112926s (0.473 KiB/s)
Info : ** Programming Finished **
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PN: (Y8C6347BZI-BLD53 SiliconID: E287 Revision: 22 FamilyID: 100 DIE:
PSoC6ABLE2
Info : reset run
Info : SWD DPIDR @x6ba@2477

PR _crecsornzrans:

5.12 Program chip-protected/Kill Mode for PSOC™ 4 MCU

The chip-level protection mechanism restricts access of the programmer application to silicon resources. In this
mode, access to flash, SRAM, and most of the registers in the PSOC™ 4, PMG1, PAG2s, and CCGx are disabled.
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Switch to Protected mode

If you try to connect ModusToolbox™ Programmer to a chip-protected PSOC™ 4/CCGx device, a warning message
indicates that the device is in protected mode. The only available operation is Erase device in this case.

ModusToolbox™ Programmer — O X

File View Options Help

Programmer |Min|'Pr|:|g4 CMSIS-DAP BULK-0T1106230321040 ~ |
|—\_|{ 7 L[ L EC} joif 4 1k
Board |Cusmm o | . 5 L L) 1]
Open Power Disconnect | Erase | Program Read Verify
Device | CY8C4548AZI-5485 v ]
Settings x
Program Settings
File C:/CYBCA54BA71-5485/CYBCA548A71-5485 chip_protect.hex E]
Reset Chip

Verify Regions

Probe Settings

Interface SWD
Clock (KHz) 2000 e
Voltage (V) 33 hd
Reset Type Soft s
Log
LLLLL® R (R L IE TETNTET TOTIITECTIONT O TR S A
Info : init_target

Info : Deferring arp_examine of psocd.cpu

Info : Use arp_examine command to examine it manually!

Info : kitprog3: acquiring device in Test Mode using "PSOC 4' target and 'xres' reset...
Info : **Failed to acquire PSoC 4 device in Test Mode

Info : cyp status: OK

ke bbb

* PSoC 4 device is in PROTECTED mode.
* Press Erase Device to clear protection. All data will be lost!

e EEE T Ty

Info : reset run
Info : Deferring arp_examine of psocd.cpu
Info : Use arp_examine command to examine it manually!

Use the Erase button to clear chip protection and move target to the open state.

To program the Kill Mode into a PSOC™ 4 /CCGx device, go to Options -> Programmer Options and enable itin
the PSOC 4 Kill Mode drop-down.

Programmer Options - ModusToolbox™ Programmer X
Name Value
Upgrade Firmware Show Pop-Up ~
OpenOCD Telnet Port 4445
PSOC 4 Kill Mode Enable o~
Enable
Disable

When trying to program a HEX file that applies Kill Mode via the special region 0x90600000, confirm this
operation by clicking Yes in the dialog.
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Warning - ModusToolbox™ Programmer X

KILL mode is about to be applied!

. After performing this operation, the target device will be locked permanently from the
external programmer. This is an irreversible operation that will make your device
inaccessible by programmer/debugger software.

Would you like to proceed?

Yes No

After programming is completed, the message in the Log indicates that the device was transferred to Kill Mode
successfully (or that an error occurred).

Ifip  ***A*FRER AR RRA AR AR RRR IR RRR AR IR RRRRRRAR IR RRS AR AR RRR RS ANR

Info : * PSoC 4 device is in 'Kill' mode.
|I"If0 A e e
Info : shutdown

Info : shutdown command invoked

Press F1 for help Powered: 2538 mV Not Connected

5.12.1 Switch to Protected mode
This operation temporarily disables access to chip's resources. Use the Erase button to clear chip protection
and move the target to the open state.

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.

2. Select the Chip Protection pull-down and select Protected mode.
A warning message asking for confirmation is displays.

Warning - ModusToolbox™ Programmer *

Chip Protected mode is about to be applied!

. After performing this operation, the target device will be locked from the external
programmer. You can unlock the target device later by performing erase device
operation.

Would you like to proceed?

Yes No

3. Click Yes to apply Protected mode for your PSOC™ 4, PMG1, PAG2S and CCGx.
When the operation completes, the log is appended with a message, and the device is disconnected from the

INfiQ s *****FRAR R AR R RRRRRREARRARRRARRRRRRERRR AR RR IR IR AR R AR A RR

Info : * PSoC 4 device is in 'Protected’ mode.
|nf0 B R e
Info : shutdown

Info : shutdown command invoked

Press F1 for help Powered: 2414 mV Not Connected
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5.12.2 Switch to Kill mode

Attention: Be aware that after applying Kill mode your device will be permanently locked from any external
debugger or programmer software. This operation is not reversible.

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.

2, To use Kill mode, go to Options > Programmer Options and enable it in PSOC 4 Kill Mode drop-down.

Programmer Options - ModusToolbox™ Programmer x
Name Value

Upgrade Firmware Show Pop-Up s

OpenOCD Telnet Port 4445

PSOC 4 Kill Mode Enable s
Enable
Disable

3. Connect to the device (see Connect Device).

4, Click the Chip Protection pull-down and select Kill mode.
A warning message asking for confirmation is displays.

Warning - ModusToolbox™ Programmer X

KILL mode is about to be applied!
After performing this operation, the target device will be locked permanently from the

- —

external programmer. This is an irreversible operation that will make your device
inaccessible by programmer/debugger software.

Would you like to proceed?

Yes No

5. Click Yes to apply Kill mode for your PSOC 4, PMG1, PAG2S and CCGx.

When the operation completes, the log is appended with a message, and the device is disconnected from the
programmer automatically.

Ifip  ***A*FRER AR RRA AR AR RRR IR RRR AR IR RRRRRRAR IR RRS AR AR RRR RS ANR

Info : * PSoC 4 device is in 'Kill ' mode.
|r|f0 A e e
Info : shutdown

Info : shutdown command invoked

Press F1 for help Powered: 2538 mV Not Connected

5.13 Program secure AIROC™ CYW20829 MCU

You can program the flash of an AIROC™ CYW20829 device in Secure lifecycle mode only by providing a valid
debug certificate file.

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.
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2, Select the programming file as described in the Load programming file section.

3. Click on the Debug Certificate option under Program Settings and select the certificate file in the
dialog.
The path will display under Settings.

ModusToelbox™ Programmer - O x

File View Options Help %

Programmer | KitProg3 CMSIS-DAP BULK-080F02C6011C040

S L i1k Joif § 1
D Board |CYW920829M2EVK—02 | - D L L L *l’ Srer
Open Power Connect Erase Program Read Verify
Device |C‘1'W2382‘BB-I]LK'4L S |
Settings x
Program Settings
File C:/hex/mtb-example-threadx-blinky-led_download.hex E
Reset Chip
Verify Regions
Flashloader Default E]
Debug Certificate C:/hex/CYW20829B0LKML/debug_cert_cem.bin ™
Probe Settings
Interface SWD
Clock (KHz) 2000
Reset Type Soft

Log

Info : Selected Programmer: KitProg2 CMSIS-DAP BULK-06180E5102122400

Info : Selected Board: Custom

Info : Disconnected - KitProg2 CMSIS-DAP BULK-06180E5102122400 FW Version 2.70.1480

Info : Connected - KitProg3 CMSIS-DAP BULK-080F02C6011C0400 FW Version 2.70.1480
Recommended to upgrade Firmware of 'KitProg2 CMSIS-DAP BULK-080F02C6011C0400°

Info : Selected Programmer: KitProg2 CMSIS-DAP BULK-080F02C6011C0400

Info : Selected Board: KIT_XMCT2_EVK

Info : Selected Board: CYW320829M2EVK-02

Press F1 for help e Not Connected

4, Connect to the device (see Connect device).
5. Click the Program button.

5.14 Program QSPI memory with patched flashloader

This feature is supported by AIROC™ CYW20829 devices, as well as PSOC™ Edge E84, XMC7100/7200 and CYT4Bx
MCUs. It allows you to specify the patched flashloader file in FLM format along with the appropriate QSPI
configuration. Patched flashloaders contain data about how your external memory is configured.

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-
downs.

2, Select the programming file as described in the Load programming file section.

3. Select the External Memory option under Program Settings (if supported).

4, Click on the Flashloader option under Program Settings and select the patched flashloader (FLM) file in
the dialog.

The path will display under Settings.
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5.
6.

Note:

5.15

1.

2.

infineon

ModusToelbox™ Programmer

File View Options Help

Programmer |KitP‘rogB CMSI5-DAP BULK-1D1612CB0028T40( -
I

g o

Power Connect

Open

|
7 Board | CYWO20820M2EVK-02 ~ |
|

Device | CYW20829B0LKML g

Settings

xp {af {

Erase Program Read

i |

Verify

Program Settings
File C:fpsocd.hex

Reset Chip
Verify Regions

Flashloader C:/hex/CYW20829B0LKML/FLM/CYW208xx_SMIF.FLM

Debug Certificate None

Probe Settings
Interface SWD

Clock (KHz) 2000

Voltage (V) 25

Reset Type Soft

Log

T O T OO WIS B T T T T e T T,

* Press Erase Device to clear protection. All data will be lost!

Info : Connected - KitProg2 CMSIS-DAP BULK-1D1612C800287400 FW Version 2.80.1506
Info : Selected Programmer: KitProg3 CMSIS-DAP BULK-101612C800287400

Info : Selected Board: CYBCPROTO-041TP

Info : Selected Device: CYBC414TAZ(-T495

Error: [CyBridge] setVioltage(2500). Error = Failed to set the desired voltage.

Info : Selected Board: CYW3920829M2EVK-02

Error: [CyBridge] setvoltage(2500). Error = Failed to set the desired voltage.

Info : Selected Board: CYW320829M2EVK-02

Error: [CyBridge] setVioltage(2500). Error = Failed to set the desired voltage.

Press F1 for help

Connect to the device (see Connect device).
Click the Program button.

Mot Connected

To be able to program custom QSPI memory, you should also provide the appropriate QSPI
configuration file (qspi_config.cfg) generated by the ModusToolbox™ QSPI Configurator tool. This file
should be placed in the same directory as the patched flashloader file; it is located and read by

ModusToolbox™ Programmer automatically.

Refer to the QSPI Configurator user guide for more information about patching flashloaders.

Program AIROC™ CYW955513EVK-01 and CYW9M2BASE-43012BT

boards

Connect the device to the host computer and perform recover device procedure as described in How to

recover AIROC™ Bluetooth® devices on failure.

Click the Programmer pull-down and select '"WICED Bluetooth-PortXX' programmer.
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g bW

6.

File

ModusToolbox™ Programmer

View Options Help

Programmer | KitProg2 CMSIS-DAP BULK-06180E51021224( .~

Info:
Error: [CyBridge] setVoltage(2500). Error = Failed to set the desired voltage.
Info :
Error: [CyBridge] setVoltage(2500). Error = Failed to set the desired voltage.
Info :

Info :
Info :
Info : Connected - KitProg3 CMSIS-DAP BULK-06180E5102122400 FW Version 2.70.1480
Info :
Info :
Info :
Info :
Info :

Error: [CyBridge] setVoltage(2500). Error = Failed to set the desired voltage.

Selected Board: CYW920829M2EVK-02
Selected Board: CYW920829M2EVK-02

Disconnected - KitProg3 CMSIS-DAP BULK-1D1612C800287400 FW Version 2.80.1506

Info : Selected Programmer: MiniProg4 CMSIS-DAP BULK-0711062303210400

Selected Board: Custom
Selected Device: CYBC4548A71-5485

Recommended to upgrade Firmware of 'KitProg3 CMSIS-DAP BULK-06180E5102122400'
Connected - WICED Bluetooth-COM18
Disconnected - MiniProg4 CMSIS-DAP BULK-0T11062203210400 FW Version 2.80.1506
Selected Programmer: KitProg2 CMSIS-DAP BULK-06180E5102122400
Selected Board: Custom
Selected Device: CYTCE5219-40LQXIT

10} B U T S e R
1 X | 401§ | 1/ |
Open KitProg2 CMSIS-DAP BULK-06180E5102122400 Power Connect Erase Program Read Verify
Device | WICED Bluetooth-COM18
lag
Settings
Program Settings
File C:/psocd.hex
Reset Chip
Verify Regions
Programming Mode | Reset
Probe Settings
Log,
Info : Selected Device: CYBC414TAZQ-T495

Press F1 for help

Powered: 1804 mV Not Connected

Note:

infineon

The CYWIM2BASE-43012BT board should be switched to Dual UART mode first, otherwise the

WICED Bluetooth programmer will be unavailable in the Board pull-down menu. To do this,
press the hardware 'Mode' button on the Kit, hold it for 3 seconds, then release it.

Open the Board pull-down and select the appropriate board name (e.g., CYW955513EVK-01)
Select the programming file as described in the Load programming file section.
Connect to the device (see Connect device).
Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.
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6 Troubleshooting

6.1 Limitations

+  ModusToolbox™ Programmer does not support RAM programming, you can program only the flash
memory of a target device, except for devices that support only RAM such as CYW9M2BASE-43012BT and
CYW955513EVK-01 kits.

+  Programming devices in DAPLink mode is not supported. You have to switch your device into CMSIS-DAP
BULK mode by pressing the mode selection button.

6.2 How to recover AIROC™ Bluetooth® devices on failure

If the program operation for an AIROC™ Bluetooth® device fails, it is possible the memory on the board has been
corrupted by a previously loaded application, or the application used a custom baud rate that the download
process does not detect.

To recover from this, it may be necessary to reset the board to factory defaults, as follows:

1. Press and hold the Recovery button (SW1).

2. Press the Reset button (SW2).

3. Release the Reset button (SW2).

4 Release the Recovery button (SW1).

6.3 Incorrect PSOC™ 6 device names (MPN) in JTAG chain

Some PSOC™ 6 target devices may be displayed with incorrect part numbers in the JTAG chain. This issue shows
only those PSOC™ 6 targets having incorrect value written to JTAG IDCode register.
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ModusToolbox™ Programmer - O

File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-0T1106230321040 ~ |

|}:_f' Board|Custom v| [ltlJ) [L,J‘ {g} {:I'

Open Power Disconnect Erase Program Read Verify

Device | CY8C627BZI-MDT6 v |

Settings

Program Settings
File C:/hexfefuse/efuses.hex
Reset Chip

Verify Regions
External Memory Incorrectly detected

Program Security Data P device in JTAG chain

Probe Settings

Interface

S
¥ DElEEmEn 'E Real physical
[0] CYBC637BZI-MDT6 / target device
Clack (KHz) 2000 J/ ~
Voltage (V) 3.3 —
Reset Type Soft e

Log

Info : read_memory: failed to read memory

Info : ** Detected Device: CYBC6247BZ1-D54

Info : ** Detected Main Flash size, kb: 1024

Info : ** Flash Boot version: 1.20.1.42

Info : ** Chip Protection: NORMAL

Infig 3 **rrrErrERErEn FRRRERRRR AR

Info : [psock.cpu.cml] Examination succeed

Info : [psoc6.cpu.cmd] Cortex-M4 ripl processor detected

Selected device does not match the physical target device _ CYBCG24TBZI-D54

infineon

You can ignore this inconsistency in device names if you see the warning "Selected device does not match the

physical target device" after clicking Connect button.
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7 Upgrading firmware

The ModusToolbox™ Programmer application allows you to upgrade KitProg2, KitProg3, and MiniProg4 device
firmware.

7.1 Upgrade KitProg2 firmware

The following upgrade process is based on the CYS8CKIT-062-WIFI-BT hardware.
1. Run the ModusToolbox™ Programmer application.
2. Go to Options > Programmer Options and select the Show Pop-Up value for the Upgrade Firmware

option.
Programmer Options - ModusToolbox™ Programmer 3
MName Value
Upgrade Firmware Show Pop-Up
OpenCCD Telnet Port 4445
OK Cancel

3. Click OK to apply the changes.

4, Connect the device with the KitProg2 firmware to the host PC. Ensure that the KitProg2 device is in
Native KP2 mode.

MedusToolbox™ Programmer — ] had

s

File View Options Help

Programmer | KitProg2-201208B202068400

0] e s e
i X | [N ! v
E Board | ~ | (o D Ead N b A R
Cpen Power Connect Erase Program Read Verify
Device | s
Settings x
Program Settings
File C:fhex/efuse /efuses. hex E
Reset Chip
Probe Settings
Interface SWD
Voltage (V) 14
Reset Type Soft
Log
Info : #6: psoc6_super_cmd (virtual) at Ox 16000000, size 0x00000000, buswidth 0, chipwidth 0 A

Info : #7 : psoc6_efuse_cmd (virtual) at 0x90700000, size 0x00000400, buswidth 1, chipwidth 1
Info : #8 : psoc6_smifl_cm0 (cmsis_flash) at 0x18000000, size 0x04000000, buswidth 4, chipwidth 4
Info : #9: psoct_smifl_cm4 (virtual) at 0x18000000, size 0x04000000, buswidth 0, chipwidth 0
Info : Flash banks detected
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PN: CYBC634TBZI-BLDS2 SiliconlD: E20T Revision: 22 FamilylD: 100 DIE: PSoCGABLE2
Info : Disconnected - Mi niProg4 CMSI5-DAP BULK-OT11062203210400 FW Version 2.80.1506
Info : Disconnected - KitProg? CMSIS-DAP BULK-201208B202068400 FW Version 2.80.1506
Info : Disconnected - KitProg2 Bootloader-B202020812200684
Info : Connected - KitProg2-2012086203068400 FW Version L5.0
Recommended to upgrade Firmware of "KitProg2-20120862023068400
Info : Selected Programmer: KitProg2-201208B8203063400
Error: [CyBridge] setVoltage(0). Error= The requested voltage "0 mV' is not supported by this device. (Supported the range of voltages — mV: 1800 -
5000)

Press F1 for help oo Not Connected
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5. If LED2 is off, press the SW3 (Mode Select) button and hold it for about 1 second. When LED2 is on, the
device is ready for upgrading the firmware.
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A warning dialog displays with the "Firmware is Out of Date" message.

Warning - ModusToolbox™ Programmer

The firmware of the programming device 'KitProg2-2012088203068400" is out of date.

To update the firmware, press 'Upgrade Firmware' button or navigate to the Options
menu and choose the "Upgrade Firmware' option

OK Upgrade Firmware

6. Click the Upgrade Firmware button to start the upgrade process.

After the upgrade process completes, the message "Firmware of 'KitProg2-xx' upgraded successfully" displays
in the Log view. The KitProg2-xx programmer disappears from the Programmer drop-down. The Board drop-
down is populated with the names of the supported KitProg3 Kits.
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ModusToolbox™ Programmer - O X

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B2030684( - |

o P e e pee
C L ixXF qoif § ivE
B Board | CYBCKIT-062-BLE ~~ LJ D v v - \l’ v
Open Power Connect Erase Program Read Verify
: Custom ~
Device
Scanned Boards
Settings CYBCKIT-062-BLE =
CYBCKIT-062-WiFi-BT
Program Settings
CYWS943012PeEVE-01
Fil
. . =)
Reset Chip V7110
Verify Regions
CYT1L1
External Memory
CYT112
Program Security Da
Bral 03 v o
Probe Settings "
Interface SWD
Clock (KHz) 3200
Voltage (V) 3.3
Reset Type Soft
Sflash Restrictions Erase/Program USER/TOC/KEY allowed < | v
Log
Info : [CyBridge] Bootloading of DAPLink. 2

Info : [CyBridge] Verifying of DAPLink.

Info : [CyBridge] The upgrade completed.

Info : Firmware of 'KitProg2-2012086202068400" upgraded successfully

Info : Disconnected - KitProg2-201208B203068400 FW Version 1.5.0

Info : Disconnected - KitProg3 Bootloader-B203020812200654

Info : Connected - KitProg2 CM3IS-DAP BULK-201208B202068400 FW Version 2.80.1506
Info : Selected Programmer: KitProg2 CMSIS-DAP BULK-201208B202068400

Info : Selected Board: CYSCKIT-062-BLE

Info : Selected Board: CYSCKIT-062-BLE

Press F1 for help _ Not Connected

7.2 Upgrade KitProg3 on kit or MiniProg4 firmware

Follow this process to upgrade KitProg3 on a kit or MiniProg4 firmware:

1. Run the ModusToolbox™ Programmer application.

2. As needed, go to Options > Programmer Options and select the Show Pop-Up value for the Upgrade
Firmware option.

3. Connect the KitProg3/MiniProg4 device to the host PC. A warning dialog with the "Firmware is Out of
Date" message displays.

Warning - ModusToclbox™ Programmer

The firmware of the programming device 'KitProg2 CMSIS-DAP
BULK-201208B202068400" is out of date.

To update the firmware, press 'Upgrade Firmware' button or navigate to the Options
menu and choose the "Upgrade Firmware' option

OK Upgrade Firmware

4, Click the Upgrade Firmware button to start the upgrade process.
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After the upgrade process completes, the message "Firmware of 'KitProg3-xx' upgraded successfully" or
"Firmware of '"MiniProg4 xx' upgraded successfully" displays in the Log view.
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